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Proxac: an editor for program transformation
Jan L.A. van de Snepscheut

This note is an introduction to an editor oriented to the production of programs and proofs.

1 Introduction and overview
The development of programs from their specication via a process known as transformational programming is in principle well-known. Yet it is rarely practiced because the process is often tedious and
error-prone. We have developed an editor that supports this programming method by automating the
tedious parts of it.
The editor, called proxac for program and proof transformation and calculation, can be found in
~modula3editproxac. Writing this editor was, and is, a challenging undertaking. Diana Finley was
instrumental in getting this project underway. Greg Davis contributed many ideas and helped getting
the program to the point where it actually became usable. My thanks go to both of them.
Figure 1 contains a view of the editor. It shows the conguration after expression
max@sum@segs

has been entered on the rst EDIT line and the three denitions in the rightmost window have been
applied to it. The example as well as the transformation rules are taken from 1. The notation used
is some concise programming language, and doesn't concern us too much now. The underlining of the
last line in the edit window indicates the expression that is the focus of attention. We illustrate how a
transformation step is carried out. Figure 2 contains the conguration after the rst transformation rule
has been selected. This selection is carried out by moving the mouse to the rules window and depressing
the # and " -keys until the proper rule is underlined.
Next, pushing the a-key will apply the rule to the expression that is the focus of attention. The
editor attempts to match the focus against the left-hand side or the right-hand side of the rule. In this
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Figure 1: The window
case, no such match will be found and then the editor proceeds by attempting to match a subexpression
of the focus against the rule. To suppress this recursive matching, hold down the Control key when
pushing the a-key. In this particular case, the subexpression that matches the left-hand side of the rule
is expression
+*@++

provided that + is substituted for f in the rule. Given this substitution, which is automatically generated
by the editor, the right-hand side of the rule reduces to
++*@+**

and these two results are then displayed by the editor as show in Figure 3. Line
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Figure 2: The window
=  MapPromotionf:=+ 

indicates that the programs preceding and following it are equal, and that their equality is justi ed by
the rule labeled MapPromotion. The justi cation can be checked by substituting + for f in the rule. The
result of the replacement is shown in the new focus.
Figure 4 contains the con guration after a few more steps. The same text can be found in Appendix
where the font size is not as minuscule.
The idea of the transformational programming method is that the rst line in Figure 4 is the speci cation, a program that clearly expresses the job to be carried out, but possibly in an ine cient way.
Each of the transformation steps is known to be correct, they are part of the theory that comes with
the programming language at hand. Each transformation preserves the program's correctness and may
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Figure 3: The window
improve its eciency. In the example, the program is given a list of integers, not necessarily all positive.
A segment is a consecutive sublist of the given list and each segment has a sum. The problem is to
compute the maximum of all those segment sums. The initial program uses some standard functions to
rst generate all segments, then compute all their sums, and nally compute the maximum thereof. If
the given list has length n the running time of this program is proportional to n 3 The nal program is
much trickier but runs in time proportional to n If we know that the transformation rules are correct,
then the resulting ecient program is known to be correct also.
:

:

JAN 183 -4

Figure 4: The window

2 Expressions
In this section we describe the notation used for expressions. This part is strongly in uenced by a proof
editor reported in 2 . Compared to most theorem provers or proof checkers, the outstanding feature is
that the notation is based on inx and prex and postx expressions instead of on function application.
The main reason is that being able to write
a +b +c

instead of the cumbersome
sum a sum b c 
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let alone having to distinguish between this and sum sum a b  c   is such an enormous gain that
in x expressions are a sine qua non. Every operator has a number of attributes that determine its
interpretation. One of its attributes is whether it is an in x, pre x, or post x operator. Every in x
operator has a number of additional attributes.

 Every operator has one of the following associativity attributes:








associative, in which case parentheses can be omitted from expressions like x y z  . We
write ASSOCIATIVE  for associative operators.
left-associative, in which case x y z stands for x y  z . We write LASSOCIATIVE 
right-associative, in which case x y z stands for x y z  . We write RASSOCIATIVE 
not associative, in which case x y z is unacceptable.
One may write LASSOCIATIVE  ^ RASSOCIATIVE  for ASSOCIATIVE  .
An in x operator may be conjunctive. For conjunctive operator  expression x  y  z equals
x  y ^ y  z . A conjunctive operator is not associative. We write CONJUNCTIVE . One
can mix various conjunctive operators. If both  and are conjunctive, x  y z equals
x y ^ y z.
An in x operator may be transitive. For transitive operator  expression x  y ^ y  z
implies x  z . We write TRANSITIVE .
An in x operator may be idempotent. For idempotent operator  expression x x equals x :
We write IDEMPOTENT  .
An in x operator may or may not have a dual. If operator  has dual  then x  y and y  x
are equal. An in x operator is symmetric or commutative just when it is its own dual. We write
DUAL = .
An in x operator may have a left unit LUNIT  , and it may have a right unit RUNIT : If
LUNIT  = l then l e = e : If RUNIT  = r then e r = e : If both are de ned, they have to
be equal and we write UNIT  for the unit of :
An in x operator may have a left zero LZERO  , and it may have a right zero RZERO : If
LZERO  = l then l e = l : If RZERO  = r then e r = r : If both are de ned, they have to
be equal and we write ZERO  for the zero of :

Following Dijkstra, we write an explicit in x operator for function application, such as b :n for the
application of function b to argument n : If function max has two arguments, we write max :x :y and
stipulate that : associates to the left. This boils down to saying that the previous function application
can be read as max :x :y and this in turn corresponds to how we usually Curry a function with more
than one argument: max is a function of one argument that returns a function of one argument.
We write @ for function composition, which is an associative operator. We have
f @g @h :x = f :g :h :x 
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We use the following notation for functions. It is inspired by our notation for quantication. For
example,
8 n j n 0 . n +1

!=

n + 1  n!

stands for the universal quantication of term
Similarly,
9 n j n 0 . n +1

!=

n +1

!=

n + 1  n!

over all

n

for which

n0

holds.

n + 1  n!

stands for the existential quantication of the same terms. It is therefore useful to think of
n j n  0 . n +1

!=

n + 1  n!

as a unit in its own right to which a quantier can be applied. We think of it as the function that
maps n to n + 1 ! = n + 1  n ! for all n for which n  0 holds. Quantier Q is then a prex
operator that is applied to a function. It has two attributes in addition to being a prex operator.
One is the inx operator INFIXOPERATOR Q that Q is the continued version of, and the other is
the constructor function CONSTRUCTOR Q that is applied to all terms before subjecting them to the
inx operator. Inx operator INFIXOPERATOR Q should be symmetric and associative.
are some
P hasHere
examples. Universal quantication 8 has attributes ^ and id : Summation
attributes +
and id : Numeric quantication N has attributes + and the function that maps true to 1 and false
to 0: Set formation has attributes  and the function that maps x to fx g:
The range of the bound variable s is written between the symbols j and .: The construct jtrue
may be omitted. For example, the function that yields the average of two numbers is written

x  y . x + y =2

:

By the way, we switched from the notation

x  y : x  0 : x + y =2
to

x  y j x  0 . x + y =2
to keep the door open for the introduction of type declarations, which might look like

x  y : real j x  0 . x + y =2

:

We admit operators as function parameters also. For example, we write

x  PREFIX  y . :::
for a function whose rst argument is any expression, whose second argument is a prex operator, and
whose third argument is an any expression. Similarly, one can write
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!
INFIX number
QUANTIFIER Q
for other operators. Pre x and post x operators are unary. The integer in the case of an in x operator
indicates its precedence level. Any integer number can be used as a precedence level a higher number
implies that the operator binds more strongly. Pre x and post x operators bind even more strongly than
in x operators.
Below we describe how attributes of operators such as their associativity, unit elements, and so on
can be described and one may include requirements on operator parameters in the function's range as
one would for other parameters. Those properties are also used by the parser when parsing the function's
body.
In some applications such as the BirdMeertens calculus 1 one nds in x expressions from which
the leftmost or the rightmost operand has been omitted, such as 2 . These are functions, but it would be
painful having to write x j true . x  2 or x . x  2 instead of simply 2 . These incomplete expressions
have become known as left and right sections the adjective indicates which operand is missing .
Quite often, we have a need for writing an expression together with some substitutions that need to
be carried out. The substitutions are understood to be performed simultaneously, so that x  y x :=
y + 1 y := x + 1 is equivalent to y + 1  x + 1 .
The goal of the editor is to come up with a sequence of transformation steps that connect a number
of expressions. Such a sequence is called a calculation. It is a sequence of one or more formulae, and each
formula is connected to the next by an operator. The connective is accompanied by a hint. It is typically
something like
POSTFIX

=
=

a+b*nn:=2
distribution
a*n+b*nn:=2
reduce
a*2+b*2

and we treat such a calculation also as an expression. It is the presence of the hints, written in curly
braces, that distinguishes them from other expressions.

3 The transformation menu
As shown in Figure 4, the last transformation step is not an application of one of the rules from the rule
window, but an applications of one of the prede ned rules called Reduce. In this section, we describe the
transformations carried out by Reduce and other prede ned transformations.
3.1

Reduction

The Reduce action is activated by either pressing the r-key in the edit window, or by downclicking the
mouse button on the Transformation menu, which will pop up a menu, followed by an upclick on the
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option. Reductions are rst applied recursively to all subexpressions of the current focus, and
then to the expression itself. To suppress this recursive application, hold down the Control key when
activating the Reduce action. The reduction is applied exactly to the focus, the underlined expression,
and not to some subexpression thereof. The reductions are tabulated below.
Let be a prex operator, ! a postx operator, and an inx operator.
Reduce

LUNIT 
RUNIT 
UNIT 
LZERO 
RZERO 
ZERO 
TRANSITIVE 
ASSOCIATIVE 
LASSOCIATIVE 
RASSOCIATIVE 
CONJUNCTIVE 
IDEMPOTENT 
DUAL 
INFIXOPERATORQ
CONSTRUCTORQ
x = x
x  x
x  x
x 6= x
x  x
x  x
x,y|range . expr.a.b
x|range . expr.a.b
x,y,z|range . expr.a.b
f@g@h.x

a
b
.x

a
b
c.x
a
b
c
.x

a
b
c
.x.y
.x
!.x
.x.y
.x
id.x
l
x
x
r
l
x

the left unit element of
the right unit element of
the unit element of
the left zero element of
the right zero element of
the zero element of
the boolean transitivity attribute of
similar
similar
similar
similar
similar
the dual of
the inx operator of quantier Q
the constructor of quantier Q

true
true
true
false
false
false
xy
expra b
exprx
a :b
xy
xy
zjrangea b .expra b
f.g.h.x
x
a
b
x
a
b
c
a
b
c
x
x
a
b
c
x
x!
x
y
x
x
x
x
l

provided
provided

xy
rangea b holds
rangex
a holds

y

if l=LUNIT
if r=RUNIT
if l=LZERO
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x
r
x
x
x . x
x .  x
x . x !
x . a x
x . x a
x,z . x y

a
y

z

xy
expre f
Q
INFIXOPERATOR Q
c=CONSTRUCTORQ
false . expr
UNIT 
i=k . expr
c.expri:=k 
i
i=k . expr
expri:=k
c=id
i
a
b . expr
Qi | a
b . expr
Qi | b . expr
a
b . expr
Qi | a . expr
Qi | b . expr

for quanti er , let
|
|
|
|
|

if  6= x
if ! 6= x
if x not free in a
if x not free in
if x,z not free in



!
a

exprx:=e,y:=f
Qi
Qi
Qi
Qi
Qi

if r=RZERO 
if IDEMPOTENT

r
x
id

=

f g  fh2gc

a
y

and

_
_

a  h1 b



^:

f

g

a  h1 h2 c

provided does not occur in k
if
and does not occur in k
if is idempotent or
if a ^ b = false
if  and  can be combined to

In the last rule, for reducing a calculation, there is the proviso that  and  can be combined. The
rule for combining operators is tabulated below. For any in x operator 

 and = can be combined, giving 










provided  is a transitive operator

The last two lines indicate that we should establish some relation between operators  and ' for which
we have x ' y = x  y _ x = y : Right now, it is an ad-hoc thing.
3.2

Factorization and distribution

A transformation that is carried out frequently is to switch from a b + c to a b + a c  which
is called distribution, or vice versa, which is called factorization. The Transformation menu oers two
distribution and two factorization operations: one that operates on the left, and one on the right. Going
from a b + c to a b + a c is called a left distribution, whereas going from b a + c a to
b + c a is called a right factorization.
Left distribution is applied to an in x expression, say x y z : It distributes the whole expression
minus the last term, that is section x y  through the last term, that is through z : The result depends
on the form of z : Notice that x y acts just like a pre x operation, and one might correctly suspect
that expression z works in a similar fashion. It is also perfectly okay for x to be missing, in which
case we have left-sectioned results.
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x*y*a+b

transforms to

x*y*a+x*y*b

x*y*v j R . t

v j R . x*y*t

x*y*Qv j R . t

Qv j R . x*y*t

provided v does not occur in
where Q is a quantier and
v does not occur in x*y*

x*y*

Factorization is just the opposite.
Observe that the transformation from a  b + c to a  b + a  c makes sense only if  leftdistributes through + in the theory that one is working with. This condition is checked by the editor.
Also observe that the transformation from f : x + y to f :x + f :y is an instance of a left distribution.
3.3

Reverse

This transformation reverses the order of the operands in an inx expression and changes the operator to
its dual. If the focus is a conjunction, it reverses the order of the operands and operators, and transforms
each operator into its dual. If the focus is a calculation, all steps are put in reverse order, and all
connectives are replaced by their dual.
3.4

Flatten

If an expression happens to contain super uous parentheses, as in a + b + c  they can be removed by
which transforms the expression into a + b + c:

Flatten

3.5

Copy

This operation makes a plain copy of the expression without any transformation being carried out.
3.6

Swap Exprs

This operation requires the selection of a secondary focus in addition to the rst focus. See section 4 for
a description on selecting a secondary focus. The eect of executing this operation is to swap the two
expressions. They are assumed to be siblings: operands of one and the same symmetric inx operation.
3.7

Regroup

This operation requires the selection of a secondary focus in addition to the rst focus. They are assumed
to be adjacent siblings. Regrouping inserts a pair of parentheses around these two expressions. For
example, regrouping expression a + b + c when a and b are the primary and secondary focus, yields
a + b + c:
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3.8

SplitConj

This operation requires the focus to be a conjunctive expression, like
conjunction of its individual terms, like a b ^ b c :
3.9

a

b

c

and splits it into the

Rule with Hint

This operation is a form of rule application where the editor is rst given a hint as to which substitution
to apply. For example, if rule
RULE CaseAnalysis : a b

.

a

=

a^b

_ a ^ :b

is applied to expression
x=y

one might give the hint to choose s  0 for b to produce the new expression
x=y

^ s0 _

x=y

^: s0

:

There is no way that the editor could have determined this substitution for b without further input. We
would write
hint b := s  0

in the input window to supply the hint, focus on the rule, and then apply the transformation.
3.10

Substitute

This operation is a form of rule application in which the rule is not given in the rules window, but is
given as an expression in the edit window. This expression is taken from the secondary focus see next
section and is often used to transform an expression like
a"2

r

b"2

^ a=0

0"2

r

b"2

^ a=0

into
by selecting a = 0 with the secondary focus, by selecting the initial
then applying the Substitute transformation.

a

with the primary focus, and by
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4 The focus menu
So far, the focus of attention has always been the last line of the calculation in the edit window. Sometimes, we want the focus to be narrowed to a subexpression thereof. And sometimes the focus is on an
expression that is not part of the last line. The operations in the selection menu allow another expression
to be selected as the focus of attention. Six operations are provided: In, Out, Left, Right, Up, and Down.
Their respective e ect is to shift the focus to a subexpression, to a superexpression, to the expression to
the left in some list , to the right, to the expression one line up, or to the expression one line down. For
example, to shift the focus from c to b in expression a + b c + d + e one cannot just apply Left
because c is already the leftmost expression in its list. Instead, one would go through Out to shift the
focus to c + d + e then Left to shift the focus to a + b then In to shift the focus to a and nally
Right to shift the focus to b The Left, Right, Up, and Down operations can also be activated via the
arrow keys.
We have mentioned the need for a secondary focus. Operation Set Focus 2 sets the secondary focus
to whatever expression holds the primary focus. The primary focus remains unchanged. The primary
focus is indicated by solid underlining, and the secondary focus is indicated by dotted underlining. When
the two foci coincide, the expression is highlighted instead of underlined.
The prseent version of the editor su ers from some inconveniences that are to some extent due to
my inability to understand the underlying window system. The program is written in Modula3 and
uses FormsVBT to set up the windows and communicate with them. When the program is started, the
windows are set up, but no underlining is shown. Even so, there is a focus but for some mysterious reason
it is not shown. Click in the edit window with the left mouse button and use the arrow keys to change
the focus. You should now see an underlining appear and this is the focus. Whenever you change your
action to another window, for example when you were editing and then want to move up or down the
focus in the rules window, you have to click in the new window rst. This causes the underlining in the
old window to disappear. It does not remove the focus, but it does remove the underlining.
:

5 The Edit Menu
The Edit menu o ers four buttons.
 From Keyboard

Replaces the expression that holds the focus with the expression read from the input window.

 To Keyboard

Writes the expression that holds the focus to the input window.

 Delete Step

Removes the last step in a calculation, provided it is the focus.

 Undo

Not yet implemented.
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6 The File Menu
The File menu oers a number of buttons, including the following.
Open

To read a module from a le.
Save
Save As

To save a module in a le.
Print LaTeX

Not yet implemented.
Quit

To terminate the program.

7 Notations
We have explained that the editor is primarily based on expressions written in in x notation. Sometimes
one encounters expressions written in a very dierent format. For example, one writes jx j for the absolute
value of x or WHILE b DO s for a loop in some program notation. It is, therefore, possible to introduce
notations other than in x operators. Right now, this mechanism is sometimes a bit clumsy and not
thought through it is likely to change a bit.
A notation like the loop construct can be declared by writing
NOTATION WHILE ! DO !

In this example, there are two so-called keywords and two parameters. The parameters are anonymous
and their position is indicated by exclamation marks. One may substitute any expression for such a
parameter. A keyword need not be a sequence of letters it may also be an operator, or any of the special
symbols , , ,, :, or | that cannot be used as operators. Keywords and parameters need not alternate.
One restriction in the present version is that the rst element is a keyword, not a parameter.
So much for the simple case in which one expression is substituted for a parameter. Sometimes it
is ever so nice to be able to substitute a list of expressions for a single parameter. For example, when
writing functions, we write a list of variables between the opening and the j or . symbols. The
appendix contains an example of the speci cation statement, which is written
SPEC r,q:true,r^2 =s q^2

 q=r+1 

in which keyword SPEC is followed by a list of names interpreted as the names of those variables that
can be assigned a new value through the statement . It is obviously highly undesirable to having to write
lots of declarations
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NOTATION SPEC ! : !, !
NOTATION SPEC !,! : !, !
NOTATION SPEC !,!,! : !, !

Instead, we write
NOTATION SPEC !LIST : !, !

and instantiate it with as many expressions as desired well, one or more . They are separated by commas.
There is no way to restrict the expressions to being identi ers only.
In some cases, the parameters are actually introducing new scopes. This is the case for the bound
variables of functions, and it might be the case for newly introduced constructs as well. In such a case,
we do not write ! but write ? instead. For example,
FOR ? := ! TO ! DO ! END

could be an attempt to write a for loop in some programming language with the intent that the control
variable be local to the loop. To indicate the scope of the newly introduced variable, in this case to
indicate that the scope is the body of the loop but not the two bounds, we name the variable and list it
in the other parameters.
FOR ? v

:= ! TO ! DO ! v

END

For the sake of completeness, we also have
?LIST v

to allow a list of new bound variables, and
! v,w

to indicate that this parameter is included in the scope of both the v and the w variables. Warning: Not
all of these constructs have been implemented completely yet .

8 Modules
In this section we discuss the module structure that has been ignored so far. As can be seen from the
Figures, the edit window starts with the lines
MODULE MaximumSegmentSum
IMPORT squiggol

whereas the actual editing was done on the expression following the line
EDIT
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In this section we discuss the role of modules. First, what does a module look like? A module starts
with a heading that lists the name of the module. In the example, the name is MaximumSegmentSum. A
module contains a list of items. Each item is a declaration of an identi er, an operator, or a notation,
is an import, is the statement of a property, or is a rule. The second line of our example imports the
module named squiggol. It is read from le squiggol.mod. Here is the text of that module.
MODULE squiggol
DECLARE INFIX 0 ++
PROPERTY ALLf,g|f@g *

= f*

@ g*

DECLARE INFIX 0 --
DECLARE INFIX 0 --
DECLARE tails, inits
RULE MapPromotion: f |
f * @ ++  = ++



@ f *

*

RULE ReducePromotion: INFIX 0 + |
| ASSOCIATIVE+ |
+  @ ++  = +  @ +



*

RULE HornerScheme: INFIX 0 +, INFIX 0 & |
ASSOCIATIVE+  ASSOCIATIVE&  ALLa,b,c|a+b &c =a&c +b&c
+  @ &  * @ tails = + UNIT&
@ &
-- UNIT&
RULE Accumulate: f,e |
f -- e * @ inits = f -- e
DECLARE INFIX 0 ^
PROPERTY ASSOCIATIVE^
PROPERTY ALLa,b,c|a^b +c =a+c ^b+c
RULE definition: max = ^



RULE definition: sum = +
RULE definition: segs = ++



*


@ tails *

@ inits

This module contains examples of many of the constructs. For example,

|
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DECLARE INFIX 0 ++

declares ++ to be an inx operator of precedence level 0. Prex and postx operators are declared with
the constructs
DECLARE POSTFIX !

and
DECLARE PREFIX not

and a quantier is declared as
DECLARE QUANTIFIER SUM

The squiggol module also shows the declaration of identiers tails and inits. One often declares
identiers that are not operators, but special constants. In the module above, tails and inits are
functions that are not dened in the module, although some of their properties are revealed in the rules
that follow. Properties can also be revealed using a PROPERTY. An example is
PROPERTY INFIXOPERATORSUM=+ 

CONSTRUCTORSUM=id

which states that quantier SUM is the well-known summation quantier. Often, properties of operators
are given in such a PROPERTY statement. One might, for example, wonder why
PROPERTY DUAL^=^

was not included in the module. It was not needed. The editor uses the information revealed by
declarations and properties when parsing expressions, and when checking the applicability conditions of
certain reductions and transformation rules.
The RULE construct is the one to introduce rules. We have seen that rules are crucial in the operation
of the editor, and the example shows how they are introduced. The keyword RULE is followed by the
name of the rule, a colon, and the rule itself. A rule is, in general, a function whose body is an equation.
Here is an example. Horner's rule is
=

=

@  =  @ tails

 @  6! UNIT 
for associative operators and  provided
8 x  y z :: x y  z = x  z y  z
UNIT

holds. The interpretation is not known" to the editor, so it is not relevant to us here. The applicability
condition is similar in spirit to the condition on the range of a function, and that is why it is represented
in the same way. The range indicates the condition under which the function can be applied to its
parameters. The parameters are the operators and  and the function body is
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@  =  @ tails = UNIT  @  6! UNIT 
The body might also be written as a calculation of two or more steps and then the rule's body can be
considered to be equal to the reduced version of that calculation see section 3.1 .
The complete rule for Horner's scheme is shown in the listing of the squiggol module. In the rules
window, a shorthand version of the rule is printed. It consists of the function body, preceded by the
rulke name only. If you want to see the full version of the rule that is presently selected the one that
is underlined , press the button on top of the rules window. It pops up a window with the rule in its
complete form.
The main operator of a rule body need not be the equality operator. If a dierent operator is used,
one should be careful in its application. Application of a rule to an expression extends a calculation with
a hint, an operator, and a new expression. The operator is copied from the rule body. This may lead to
surprises" in what are sometimes called negated" contexts. For example, rule
RULE twice : a j a  0 . a  2  a
applied to x in -x produces
=



-x
 twicea:=x
-2*x

and not
-x
 twicea:=x
-2*x

which would be slighty more correct. The editor attempts to verify that a rule is applied in a monotonic
context, but these attempts are presently incomplete.
The squiggol module also contains examples of rules that have no parameters and, therefore, serve
only as denitions.
When a module m is imported in another module n  then the scope of all declarations occurring
in m extends to n : That is why we can use, for example, operator ++ in module MaximumSegmentSum.
Also, all properties and rules declared in m extend to n : Declarations, properties, and rules that were
imported into m via an import clause in m itself are not extended to n : When needed, n should
import those directly.

9 The Denitions menu
The Definitions menu contains two buttons: pushing the Operators button produces a window with
all operators that have been dened, and pushing the Notations button produces a window with all
notations that have been dened. Either window is closed by pushing the C button in its left top corner.
The predened operators are
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function application
@
function composition
~
boolean negation
integer negation
*
integer multiplication
integer division
n
integer remainder
+
integer addition
integer subtraction
=n
boolean conjunction
n=
boolean disjunction
=
equality
#
inequality
less than
=
at most

greater than
=
at least
--
implication
-explication
ALL
universal quantication
There are no predened notations.
.

LUNIT=id, LASSOCIATIVE
UNIT=id, ASSOCIATIVE

UNIT=1,ZERO=0,ASSOCIATIVE,DUAL=*
RUNIT=1,LZERO=0,LASSOCIATIVE
LZERO=0,LASSOCIATIVE
UNIT=0,ASSOCIATIVE,DUAL=+
LASSOCIATIVE
UNIT=true,ZERO=false,IDEMPOTENT,ASSOCIATIVE,DUAL= =n
UNIT=false,ZERO=true,IDEMPOTENT,ASSOCIATIVE,DUAL= n=
DUAL = =,CONJUNCTIVE,TRANSITIVE
DUAL = #,CONJUNCTIVE
DUAL = ,CONJUNCTIVE,TRANSITIVE
DUAL = =,CONJUNCTIVE,TRANSITIVE
DUAL = ,CONJUNCTIVE,TRANSITIVE
DUAL = =,CONJUNCTIVE,TRANSITIVE
DUAL = --,CONJUNCTIVE,TRANSITIVE,LUNIT=true
DUAL = --,CONJUNCTIVE,TRANSITIVE,RUNIT=true
INFIXOPERATOR= =n ,CONSTRUCTOR=id

10 The Modify EDIT menu
The Modify EDIT menu oers nine buttons. This part of the interface is sometimes rather clumsy, and
will hopefully make that denitely be improved. The nine buttons and their functions are:
 add EDIT
adds an EDIT

item to the module in the edit window

 delete EDIT

deletes the EDIT item containing the focus from the module

 EDIT to RULE

changes the status of an EDIT item to a RULE. This adds the item to the rule window.
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EDIT to PROPERTY

changes the status of an EDIT item to a PROPERTY
EDIT to IMPORT

changes the status of an EDIT item to an IMPORT
EDIT to DECLARE

changes the status of an EDIT item to a DECLARE
RULE to EDIT
PROPERTY to EDIT
DECLARE to EDIT

these three have not yet been implemented

11 Appendix A
This appendix shows the complete text of the maximum-segment-sum example. It is identical to the text
in Figure 4, but the font size is not as minuscule.
MODULE module
IMPORT squiggol
EDIT
max@sum@segs
=
 definition 
max@sum@++ @tails*@inits
=
 definition 
max@+ *@++ @tails*@inits
=
 definition 
^ @+ *@++ @tails*@inits
=
 MapPromotion f:=+  
^ @++ @+ **@tails*@inits
=
 ReducePromotion +:=^ 
^ @^ *@+ **@tails*@inits
=
 factor 
^ @^ @+ *@tails*@inits
=
 HornerScheme +:=^,&:=+ 
^ @^UNIT+@+- -UNIT+*@inits
=
 Accumulate f:=^UNIT+@+,e:=UNIT+ 
^ @^UNIT+@+- -UNIT+
=
 reduce 
^ @^0@+- -0
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12 Appendix B
This appendix lists two modules refine and sqrt and show how they can be used to derive a program
for computing square roots by binary search. This example is almost straight from Carroll Morgan's
book 3 . The example shows both weaknesses and strengths of the current editor, but we refrain from
making comments about it now. The rst module introduces the renement calculus. Not all rules and
properties are used in the example. The main thing that is lacking is a statement of the monotonicity
properties of the statement constructors. One comment might be in order. I have written
NOTATION VAR !LIST BEGIN ! END

instead of
NOTATION VAR ?LISTv BEGIN !v END

because program variables are not exactly like mathematical variables. I don't know how to do this well
yet .
MODULE refine
NOTATION DO ! - ! OD
NOTATION IF ! - ! | ! - ! FI
NOTATION SPEC !LIST :

! , !

NOTATION ASSIGN ! := !
NOTATION VAR !LIST BEGIN ! END
DECLARE INFIX 0 
DECLARE skip
PROPERTY UNIT=skip
PROPERTY ASSOCIATIVE
RULE Assignment: x, E, P, Q | P -- Q x:=E
SPEC x: P, Q
=
ASSIGN x:=E

|

RULE Assignment: v, x, E, P, Q | P -- Q x:=E

|
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SPEC v, x: P, Q
=
ASSIGN x:=E
RULE Block: v, w, P, Q |
* provided w which may be a list
SPEC v:P, Q
=
VAR w BEGIN SPEC v, w:P, Q END
RULE StrengthenPost: v, P, Q, R | R -SPEC v: P, Q
=
SPEC v: P, R

does not occur in v, P or Q *

Q |

RULE StrengthenPost: v, P, Q, R |
SPEC v: P, Q
=
SPEC v: P, Q  R
RULE Semicolon: v, P, Q, R |
SPEC v: P, R
=
SPEC v: P, Q SPEC v: Q, R
RULE IfStatement: v, P, Q, b0, b1 |
SPEC v: P  b0  b1 , Q
=
IF b0 - SPEC v:P  b0, Q | b1 RULE IfStatement: v, P, Q, b |
SPEC v: P, Q
=
IF b - SPEC v:P  b, Q | ~b -

SPEC v:P  b1, Q FI

SPEC v:P  ~b, Q FI

RULE Loop: v, b, inv |
SPEC v: inv, inv  ~b
=
DO b - SPEC v: inv  b, inv OD
RULE TerminatingLoop: v, b, inv, bf | inv  b -- bf 0 |
SPEC v: inv, inv  ~b
=
DO b - SPEC v: inv  b  bf=BF , inv  bfBF  OD
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RULE ContractFrame: v, w, P, Q |
SPEC v, w: P, Q
=
SPEC v: P, Q
RULE RightDistr: b0, s0, b1, s1, s |
IF b0 - s0 | b1 - s1 FI  s
=
IF b0 - s0 s | b1 - s1 s FI
RULE Skip: v, P, Q | P -- Q |
SPEC v:P, Q
=
skip

The second module denes functions Floor and Sqrt, or at least the properties that are relevant here.
For example, the Floor rule states a relation between integer x and real number y. Those types can
presently not be indicated. The second rule species what in the fashionable jargon is known as a Galois
connection between Sqrt and squaring. The two rules called NotPromotion should not really be part of
this module, but they are. One might argue that they should be properties of the operators.
MODULE sqrt
RULE Floor: x,y | x = Floor.y

=  x

= y

x+1

DECLARE INFIX 10 ^
RULE Sqrt:

x,y | x=0  y=0 | x

PROPERTY

x,y | x^2 y^2

RULE NotPromotion: x,y | x

= Sqrt.y

=  x^2

= y

= x y
y

RULE NotPromotion: x,y | x = y

= ~y

= x

= ~x # y

And here is the module that is produced by importing the two modules above, stating that a program is
required for setting integer r to the value Floor.Sqrt.s and then applying lots and lots of transformations. Below is the output of the editor. I have omitted the output related to verication conditions.
The editor prints questions when it fails to verify side conditions. Also, I have added some white space
and split up lines because they became too wide. Furthermore, I have used asterisks to indicate all the
hints that I had to give as input. No other inputs were supplied other than mouse clicks .
MODULE module
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IMPORT refine
IMPORT sqrt
EDIT
SPEC r:true,r=Floor.Sqrt.s
******************************
=
Floorx:=r,y:=Sqrt.s
SPEC r:true,r =Sqrt.s r+1
=
split conjunction
SPEC r:true,r =Sqrt.sSqrt.s r+1
=
NotPromotionx:=Sqrt.s,y:=r+1
SPEC r:true,r =Sqrt.s~r+1 =Sqrt.s
=
Sqrtx:=r,y:=s
SPEC r:true,r^2 =s~r+1 =Sqrt.s
=
Sqrtx:=r+1,y:=s
SPEC r:true,r^2 =s~r+1^2 =s
=
NotPromotionx:=s,y:=r+1^2
SPEC r:true,r^2 =s r+1^2
=
Blockv:=r,w:=q,P:=true,Q:=r^2 =s r+1^2
****
VAR q BEGIN SPEC r,q:true,r^2 =s r+1^2 END
=
StrengthenPostv:=r,q,P:=true,Q:=r^2 =s r+1^2,R:=q=r+1
********
VAR q BEGIN SPEC r,q:true,r^2 =s r+1^2q=r+1 END
=
q=r+1
VAR q BEGIN SPEC r,q:true,r^2 =s q^2q=r+1 END
=
Semicolonv:=r,q,P:=true,Q:=r^2 =s q^2,R:=r^2 =s q^2q=r+1
*************
VAR q BEGIN SPEC r,q:true,r^2 =s q^2 SPEC r,q:r^2 =s q^2,r^2 =s q^2q=r+1
=
Semicolonv:=r,q,P:=true,Q:=r=0,R:=r^2 =s q^2
******
VAR q
BEGIN SPEC r,q:true,r=0 SPEC r,q:r=0,r^2 =s q^2 
SPEC r,q:r^2 =s q^2,r^2 =s q^2q=r+1
END
=
Assignmentv:=q,x:=r,E:=0,P:=true,Q:=r=0
**** ****
VAR q
BEGIN ASSIGN r:=0SPEC r,q:r=0,r^2 =s q^2 
SPEC r,q:r^2 =s q^2,r^2 =s q^2q=r+1
END
=
Assignmentv:=r,x:=q,E:=s+1,P:=r=0,Q:=r^2 =s q^2
**** ******
VAR q
BEGIN ASSIGN r:=0ASSIGN q:=s+1

END
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SPEC r,q:r^2=sq^2, r^2=sq^2
q=r+1 
END
=
 NotPromotionx:=q,y:=r+1 
VAR q
BEGIN ASSIGN r:=0  ASSIGN q:=s+1 
SPEC r,q:r^2=sq^2, r^2=sq^2
~ q#r+1 
END
=
 TerminatingLoopv:= r,q ,b:=q#r+1,inv:=r^2=sq^2,bf:=q-r 
*******
VAR q
BEGIN ASSIGN r:=0  ASSIGN q:=s+1 
DO q#r+1-SPEC r,q: r^2=sq^2
q#r+1
q-r=BF , r^2=sq^2
q-rBF  OD
END
=
 Blockv:= r,q ,w:=m,P:= r^2=sq^2
q#r+1
q-r=BF ,Q:= r^2=sq^2
q-rBF  
****
VAR q
BEGIN ASSIGN r:=0  ASSIGN q:=s+1 
DO q#r+1-
VAR m
BEGIN SPEC r,q,m: r^2=sq^2
q#r+1
q-r=BF , r^2=sq^2
q-rBF  END
OD
END
=
 Semicolonv:= r,q,m ,P:= r^2=sq^2
q#r+1
q-r=BF ,
Q:= r^2=sq^2
q#r+1
q-r=BF
rmq ,
*******************************************
R:= r^2=sq^2
q-rBF  
VAR q
BEGIN ASSIGN r:=0  ASSIGN q:=s+1 
DO q#r+1-
VAR m
BEGIN SPEC r,q,m: r^2=sq^2
q#r+1
q-r=BF ,
r^2=sq^2
q#r+1
q-r=BF
rmq 
SPEC r,q,m: r^2=sq^2
q#r+1
q-r=BF
rmq , r^2=sq^2
q-rBF 
END
OD
END
=
 Assignmentv:= r,q ,x:=m,E:= r+q 2,P:= r^2=sq^2
q#r+1
q-r=BF ,
**** **********
Q:= r^2=sq^2
q#r+1
q-r=BF
rmq  
VAR q
BEGIN ASSIGN r:=0  ASSIGN q:=s+1 
DO q#r+1-
VAR m
BEGIN ASSIGN m:= r+q 2 
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SPEC r,q,m:r^2=sq^2

q#r+1

q-r=BF

rmq ,r^2=sq^2

q-rBF 

END
OD
END
=
 IfStatementv:=r,q,m ,P:=r^2=sq^2
q#r+1
q-r=BF
rmq ,
Q:=r^2=sq^2
q-rBF ,b:=sm^2 
********
VAR q
BEGIN ASSIGN r:=0 ASSIGN q:=s+1 
DO q#r+1-
VAR m
BEGIN ASSIGN m:=r+q 2 
IF sm^2-SPEC r,q,m:r^2=sq^2
q#r+1
q-r=BF
rmq
sm^2 ,
r^2=sq^2
q-rBF 
|~sm^2 -SPEC r,q,m:r^2=sq^2
q#r+1
q-r=BF
rmq
~sm^2 ,
r^2=sq^2
q-rBF 
FI
END
OD
END
=
 Assignmentv:=r,m ,x:=q,E:=m,P:=r^2=sq^2
q#r+1
q-r=BF
rmq
sm^2 ,
**** ****
Q:=r^2=sq^2
q-rBF  
VAR q
BEGIN ASSIGN r:=0 ASSIGN q:=s+1 
DO q#r+1-
VAR m
BEGIN ASSIGN m:=r+q 2 
IF sm^2-ASSIGN q:=m
|~sm^2 -SPEC r,q,m:r^2=sq^2
q#r+1
q-r=BF
rmq
~sm^2 ,
r^2=sq^2
q-rBF 
FI
END
OD
END
=
 Assignmentv:=q,m ,x:=r,E:=m,P:=r^2=sq^2
q#r+1
q-r=BF
rmq
~sm^2 ,
**** ****
Q:=r^2=sq^2
q-rBF  
VAR q
BEGIN ASSIGN r:=0 ASSIGN q:=s+1 
DO q#r+1-
VAR m
BEGIN ASSIGN m:=r+q 2 
IF sm^2-ASSIGN q:=m|~sm^2 -ASSIGN r:=m FI
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END

OD

END
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